
For DesignBuilder v5.5 

DesignBuilder v5.5 

1. DesignBuilder Revit – gbXML Tutorial 

Introduction 

This Tutorial has been developed to help Revit users transfer their Revit BIM models to the 

DesignBuilder building performance analysis software to access data on daylighting, heating and 

cooling loads, LEED / BREEAM energy credits, UK Part-L compliance checking, energy consumption 

and comfort data for the building design.  

The Tutorial starts by explaining the fundamentals of the Revit to DesignBuilder transition process 

covering both the DesignBuilder Revit Plugin and the built-in Export gbXML method. It then explains 

how to prepare the Revit model before starting the transition process and how to check and tidy the 

final model once it has been loaded into DesignBuilder. Finally, 3 examples are provided with step-

by-step instructions on how to load a sample model provided with the Revit distribution into 

DesignBuilder. 

 

Some materials included in the Tutorial are based on Revit and DesignBuilder online help from:  

• http://help.autodesk.com/view/RVT/2018/ENU/  and  

• http://www.designbuilder.co.uk/helpv5.5/.  

Links have been provided to the original text and other relevant websites to allow you to find 

additional details. 

  

https://www.autodesk.com/products/revit-family/overview
http://www.designbuilder.co.uk/
http://help.autodesk.com/view/RVT/2018/ENU/
http://www.designbuilder.co.uk/helpv5.5/
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Understanding the Transition Process 

Although the native Revit BIM data includes considerable intelligence, it does not contain the 

volumetric/zonal data required by building performance analysis tools such as DesignBuilder. This 

data must be superimposed on top of the native Revit architectural model. It is usually referred to as 

the “Analytical Model” because it is the model on which subsequent analysis is based. 

The diagram below shows the data objects involved in the transition process from Revit to 

DesignBuilder. 

Overview of the Process 

There are currently two ways to transfer Revit BIM data to DesignBuilder: 

1. Using the DesignBuilder Revit Plugin. 

2. Using the built-in Revit gbXML export menu option to create a gbXML file which is then 

imported into DesignBuilder. 

For each of these 2 overall approaches to transferring data to DesignBuilder you can choose 

between 2 methods to generate an intermediate Analytical Model: 

a) Place rooms to create an Analytical Model (AM). This can be done either manually or for, 

closed and bounded areas, it can be done automatically. 

b) Automatically create the Energy Analytical Model (EAM). 

Data Diagram for the Revit to DesignBuilder Transition 

 

 

 
 

1. Start with a standard Revit Architecture or Revit MEP model 

2. Create an Analytical Model to the Revit model. 

3. Green Building XML (gbXML) data is generated from the 
Analytical Model. 

4. gbXML data is loaded to DesignBuilder for performance 
analysis 

http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-D94E11E7-0956-4B5B-B50F-6BB28AD09F15
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So depending on whether the Plugin or the import/export process is used and whether the EAM or 

the AM is used, overall there are 4 different methods to export Revit models into DesignBuilder. The 

diagram below summarises the processes involved with these 4 methods of data transfer.  

Exporting Revit Models to DesignBuilder 

 

 

Note: Interoperability between Revit and DesignBuilder is achieved through basically the 

same underlying gbXML processes regardless of which method is used.  

For methods 1 and 2, the preparation of the AM within Revit is the same for both plugin and export 

methods. The most important of these steps is to accurately identify the “rooms” or “spaces” in the 

model. These steps are described in more detail below. Likewise, for methods 3 and 4, the 

preparation of the EAM is the same for both plugin and export methods. Note that Revit creates the 

EAM automatically in all cases, i.e. there is no manual option. 

2. DesignBuilder-Revit Plugin (Methods 1 and 3) 

This section summarises how to use the DesignBuilder-Revit plugin to facilitate the transfer of the 

Revit BIM model geometry data and building thermal properties directly to DesignBuilder.  The 

following steps should be followed: 

a. Set up the AM or EAM. Once you have correctly set up the analytical model as described 

below in the section Preparing the Energy Analytical Model (when using the 1-Use Energy 

settings Revit export method) or Preparing the Analytical Model by adding Rooms (when 

using the 2-Use Rooms/Spaces Volumes Revit export method) you are ready to export to 

DesignBuilder. 
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b. Check Plugin settings. See DesignBuilder Settings below. 

 

c. Open in DesignBuilder. The plugin “Open” toolbar icon can be found on the Analyze menu 

within the DesignBuilder section, towards the right of the Revit toolbar as shown below. 

 

Note: The DesignBuilder “Open” plugin toolbar icon will only be available after you have 

installed DesignBuilder and run it for the first time.  

d. Check the DesignBuilder model. See Example Cases. 

DesignBuilder Settings 

Before you open your Revit model in DesignBuilder you should review the DesignBuilder transfer 

settings by clicking on the “Settings” toolbar icon of the DesignBuilder plugin. 

 

The DesignBuilder Settings dialog allows you to control the way that the transition is carried out. 

The effect of each setting is described below. 

  

General Tab 

Settings on the General tab control the behaviour at the import end within DesignBuilder. 

Priority 

This option allows you to define whether the system should prioritise reduction of gaps between 

blocks or whether to aim to minimise likelihood of open manifold blocks being generated. 
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• Minimise gaps between blocks where the gbXML surfaces are used to define block 

geometry. This is the default option as it typically gives the best results for the majority of 

BIM models imported from Revit. 

• Minimise open manifold blocks where DesignBuilder works out whether it would be better 

to use the space or surface data sets based on the criterion that the number of open 

manifold blocks should be minimised. Open manifold blocks are blocks that are not fully 

enclosed. 

Adjacency separation tolerance 

This is the maximum gap between neighbouring parallel gbXML surfaces that will be interpreted as 

being an adjacency between 2 spaces. You might enter a value higher than the default 0.01m if the 

gbXML spaces are separated by large gaps due to thick partitions or ceiling /floor voids being 

excluded from the gbXML. For example if the largest gap in the between spaces that are to be 

modelled as adjacent is 0.3m then enter 0.3m here. 

The Adjacency tolerance can also be updated, if necessary, after the import from the Advanced 

tab of the DesignBuilder Model options dialog. 

Create storey blocks 

This option is used by default to automatically identify stories by grouping adjacent spaces created 

by extruding from the floor plan with the same upper and lower Z coordinates into single blocks. This 

has the advantage of making it much easier to later modify internal layouts and it also helps to 

navigate around large models. 

Note: It is sometimes an advantage, especially in lower quality gbXML data sets, to import 

raw surface geometry exactly as defined in the BIM model. In this case the Create storey 

blocks setting should be switched off and the Allow open manifold building blocks setting 

(below) should switched on. 

Import as building blocks 

By default this option is selected and the geometric space data will be imported as building blocks 

ready for use in DesignBuilder modelling. However, you can instead import BIM space geometry as 

Outline blocks by unchecking this option. The outline blocks give an exact representation of the 

gbXML spaces in the gbXML and this can be useful for diagnosing problems with poor gbXML. For 

example if any part of a space intersects with another space then it would not be created as a 

building block, but it could still be created as an outline block to help you identify and fix any 

possible issues with intersection in the BIM model. 

Import thermal properties 

If this option is selected then DesignBuilder will load any materials, constructions and glazing system 

thermal properties present in the Revit model and assign them to surfaces and windows in the 

model. 

Allow open manifold building blocks 

Open manifold (non-enclosed) blocks are a special type of DesignBuilder block which are only 

created when models are imported from BIM. They have one or more surfaces missing which means 

that they are not fully enclosed, and this has significant consequences on what can be done with the 

block in the DesignBuilder modeller and in calculations:  

https://www.designbuilder.co.uk/helpv5.4/Content/Import_3-D_CAD_Data.htm#Allow
https://www.designbuilder.co.uk/helpv5.4/Content/Import_3-D_CAD_Data.htm#Allow
https://www.designbuilder.co.uk/helpv5.3/Content/AdjacencySettings.htm
https://www.designbuilder.co.uk/helpv5.3/Content/AdjacencySettings.htm
https://www.designbuilder.co.uk/helpv5.3/Content/Import_3-D_CAD_Data.htm#Allow
http://www.designbuilder.co.uk/helpv5.4/#Outline_Block.htm
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• Radiance and CFD calculations cannot be carried out. 

• The boolean operations used behind the scenes to manipulate block geometry are not 
possible and so only limited edit operations may be performed on open manifold blocks. In 

particular these operations cannot be performed: 

o Add surface 

o Drag block face 

o Mirror 

o Divide block using cutting tool 

o Boolean geometry operations. 

 
Because Open manifold blocks cannot use all geometry operations, the orientation of their surfaces 

cannot be reliably determined from the model and DesignBuilder must rely on the orientation data 

stored with the surface from the BIM model. This data is not always reliable and so in some cases 

surfaces are facing in the wrong orientation. The DesignBuilder Flip block surface 

orientation command should be used to check and, if necessary fix, the orientation of surfaces in all 

open manifold blocks. 

Import shading surfaces 

Shading surfaces are specially marked in gbXML data and so can be treated separately if required. 

You can choose to import shading surfaces as part of the import or not using this control. Shading 

surfaces imported through gbXML will be 2-D flat shading surfaces. 

Merge co-planar surfaces 

If the above Import shading surfaces option is selected, then you can choose to either merge any 
such co-planar surfaces or not. 

Merge Tab 

It is sometime necessary to accommodate changes made to the Revit model after significant work 

has already been done on the energy model on a previous iteration of the design. The settings on 

the Merge tab allow you to retain any settings that you may have added when previously working 

on the model within DesignBuilder. 

 

 

https://www.designbuilder.co.uk/helpv5.4/Content/AddSurface.htm
https://www.designbuilder.co.uk/helpv5.4/Content/_Drag_block_face.htm
https://www.designbuilder.co.uk/helpv5.4/Content/Mirror.htm
https://www.designbuilder.co.uk/helpv5.4/Content/_Divide_block.htm
https://www.designbuilder.co.uk/helpv5.4/Content/Boolean_Geometry_Operations.htm
http://www.designbuilder.co.uk/helpv5.4/#FlipBlockSurfaceOrientation.htm
http://www.designbuilder.co.uk/helpv5.4/#FlipBlockSurfaceOrientation.htm
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Merge with existing model 

This option allows you to load all of the important settings from the DesignBuilder model you most 

recently worked on into the latest geometry imported from Revit. 

In the descriptions below the "old" model refers to the DesignBuilder model you previously worked 

on whose settings you wish to retain, and the "new" model refers to the DesignBuilder model newly 

imported from the latest Revit model and needing settings to be loaded from the old model. 

Note: To use the plugin merge mechanism, the “old” model must be saved in the default 

folder using the default filename, typically: 

 

C:\Users\<Username>\AppData\Local\DesignBuilder\Revit\<GUID>\DesignBuilder.dsb.  

 

This can be done simply by using the Save command in DesignBuilder (not File -> SaveAs).  

 

DesignBuilder also has a manual Merge Model From File command which can be used if the 

“old” DesignBuilder model has been saved in a different location or with a different 

filename. 

When the Merge with existing model option is used, DesignBuilder makes the following changes to 

the new model:  

• Blocks, zones and surfaces are matched between the old and the new geometry based on 

their geometry and position. Where an object is matched, all hard-set attributes (those 

shown in red in model data) are copied over from the old to the new model. 

 

• All user-defined components and templates are copied from the old to the new model. 

 

• If the Merge HVAC system option is checked and a Detailed HVAC system was defined in the 

old model, then it is loaded to the new model. It is important to check that HVAC zone 

groups contain the right HVAC zones after the merge has been completed. 

 

• If the Merge assemblies option is checked, any assemblies defined in the old model are 

merged into the new model. 

 

• If the Merge component blocks option is checked, any component blocks defined in the old 

model are merged into the new model. 

 

• Openings such as windows, doors etc are merged based on a user-definable selection. The 

options are: 

 

o 1-Retain existing openings where the new openings are kept and the old ones are 

not copied over. 

 

o 2-Overwrite all existing openings where the old openings are copied to the new 

model replacing all new openings. 

 

http://www.designbuilder.co.uk/helpv5.4/#MergeModel.htm
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o 3-Merge non-overlapping openings where the old openings are copied to the new 

model wherever possible without overlapping with the openings already in the new 

model. 

Note: After using this option you should check that the merge has been completed as 

required. Note that any newly added blocks, zones, surfaces and openings in the updated 

model will not receive attribute settings from the old model that was merged in. 

Summary of the Merge process 

1. Open the Revit model in DesignBuilder. 

2. Make any modifications within DesignBuilder and save it as the “old” model. It must be 

saved in the original folder with the original filename to use the merge process within the 

plugin.  

3. Close DesignBuilder. 

4. Make any necessary modifications to the Revit model. 

5. Check the Merge with existing model options on the DesignBuilder Settings dialog as 

required to ensure that the previous modifications are merged. 

6. Open the revised Revit model in DesignBuilder. 

7. Check that that the modifications in the “old” model have been carried across to the “new” 

model. 

Revit Export Tab 

Settings on the Revit export tab provide some control over the export method to be used at the 

Revit end of the transition process. 

 

Use energy settings 

Check this option to use the EAM when generating the gbXML within Revit. 

Use room/space volumes 

Check this option to use the AM when generating the gbXML within Revit. 

Complexity 

Select the option to specify the level of detail provided for openings, and whether shading surface 

information is exported. Shading surfaces are surfaces that are not adjacent to any space and 

include surfaces that create a solar obstruction.  
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o Simple - curtain walls and curtain systems are exported as a single opening (without individual 
panels).  

o Simple with shading surfaces – the default option, same as simple, but with shading surface 
information exported. 

o Complex - curtain walls and curtain systems are exported as multiple openings, panel by panel. 

o Complex with shading surfaces - same as complex, but with shading surface information 
exported. 

Shading surfaces are not associated with any room/space (roof overhang, free-standing wall). 

o Complex with mullions and shading surfaces - same as complex, but with mullion and shading 
surface information exported. 

Mullions in curtain walls are exported as shading surfaces. A simple analytical shading surface is 

produced from mullions, based on the centerline, thickness, and offset. 

3. Exporting the gbXML file from Revit (Methods 2 and 4) 

This section summarises how to transfer the Revit model through a manual export/import process 

which is equivalent to the processes automated by the DesignBuilder Revit plugin described above. 

The process involves exporting your design as a gbXML using the Export gbXML dialog built into 

Revit. The resulting gbXML file contains energy information for the model according to the gbXML 

file structure. The gbXML schema was created to help building designers get information about the 

energy consumption characteristics of their building projects. For more information about gbXML, 

visit http://www.gbxml.org. 

The steps involved in the manual export/import process are as follows: 

a. Set up the AM or EAM. Once you have correctly set up the analytical model as described 

below in the section Preparing the Energy Analytical Model (when using the 1-Use 

Energy settings Revit export method) or Preparing the Analytical Model by adding 

Rooms (when using the 2-Use Rooms/Spaces Volumes Revit export method) you are 

ready to export to DesignBuilder. 

b. Export the gbXML file by clicking on File tab Export (gbXML). You will then be 

presented with a dialog which allows you to choose which of the 2 export methods to 

use: 

1-Use Energy Settings 

c. In the Export gbXML dialog, if you wish to use the EAM method then select the Use 

Energy Settings and click OK. 

 

d. In the Export gbXML -> Save to Target Folder dialog, navigate to the desired location for 

the exported file, specify a file name, and click Save. Revit exports the EAM to a gbXML 

file in the specified location. 

http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-586B9574-64DA-47BC-B8EC-DEF2D565928F
http://www.gbxml.org/
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-76FA41DE-D14A-4708-AE25-D4FCEE05F3C8
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This method exports the energy analytical model (EAM) created by Revit. The EAM is 

composed of analytical spaces and analytical surfaces, which are automatically created 

based on parameters defined in the Energy Settings dialog. The exported data provides an 

accurate energy model for analysis. Before using this method, define parameters in the 

Energy Settings dialog and create an EAM. For more information, see section Preparing the 

Energy Analytical model. 

2-Use Room/Space Volumes 

c. In the Export gbXML dialog, if you wish to use the AM method then select the Use 

Room/Space Volumes Settings and click OK. 

 
d. In the Export gbXML -> Save to Target Folder dialog, navigate to the desired location for 

the exported file, specify a file name, and click Save. Revit exports the EAM to a gbXML 

file in the specified location. 

 

This method uses volumes defined in the building model based on rooms or spaces in the 

model. Before using this method, you must add rooms or spaces to the model. For more 

information, see section Preparing the Analytical Model by adding Rooms. 

For both 1-Use Energy Settings and 2-Use Room/Space Volumes methods the final steps 

within DesignBuilder are the same: 

e. Import gbXML file to DesignBuilder. Once the gbXML file has been exported you can 

manually import it into DesignBuilder to perform an energy analysis. 

 

f. Check the DesignBuilder model. See Example Cases. 

4. Preparing the Energy Analytical Model 

This section explains the steps involved in setting up the EAM in Revit. After creating an energy 

analytical model, you can either open the Revit model in DesignBuilder through the plugin (method 

3) or export the model to DesignBuilder using the Use Energy Settings option (method 4).  

To create the EAM follow these steps: 

http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-89B09D35-4CDE-458C-AFBD-492FCDB66E9A
https://www.designbuilder.co.uk/helpv5.4/#Import_3-D_CAD_Data.htm
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1- Open a 3D view of the model. 

2- Create an energy analytical model by clicking on the Analyze toolbar tab on the Energy 

Optimization panel click on the Create Energy Model icon.  

Optional steps to adjust energy settings and update the EAM before exporting it: 

3- Click the Energy Settings icon to open the Energy Settings dialog.  

4- Check and change any settings as required. See detailed information in the Energy Settings 

dialog section below. 

5- If you make any changes you must update the EAM to reflect the changed settings. To do 

this delete and recreate it. 

Energy Settings dialog 

The energy settings control the behaviour of the energy model creation. They also control the 

optional use of additional information specified in the Revit model, such as material properties and 

thermal space properties. These settings are used the same way regardless of whether you are using 

the Plugin or manual export/import.  

To open the Energy Settings dialog, click Analyze tab Energy Optimization panel  (Energy 

Settings).  

 

When performing the initial energy optimization, you do not need to change energy settings. Learn 

the overall paradigm of Energy Optimization for Revit before changing the default energy settings. 

http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-36B2F66A-E423-4D9C-B266-3ABA57573F4A
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-A77EF18D-0EB8-47D3-A653-6370D9F1374A
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Note: The instructions in the online help assume that the Energy Settings dialog uses the 

default values. These are the default settings for Revit 2017 and later models. If you have an 

older model or have previously used Energy Analysis for Revit with different settings, you 

should review the online help to learn the impact of these settings. 

Mode 

Revit offers 3 modes for creating the energy model from the architectural model. For all cases, 

however, you should use the default mode: Use Conceptual Masses and Building Elements. 

This mode does not require that the architectural model include both conceptual masses and 

building elements. You can use this mode when the model contains only masses or only building 

elements. It also supports a mix of the 2 types of elements, which is useful when performing energy 

optimization using the Mixed Design method. 

The other modes relate to legacy behaviour. They are provided only to support older models. Some 

advanced energy settings relate only to these legacy modes; those settings are unavailable when the 

mode is set to Use Conceptual Masses and Building Elements. 

Ground Plane 

Specify the level below which the energy model surface is assumed to be in contact with the ground 

for heat transfer. 

For a building where the ground floor is partially underground (for example, built into a slope), use 

the level with the most exposure as the ground plane. The differences in the resulting energy 

analysis are typically fairly minor. 

Project Phase 

All building elements and/or conceptual masses assigned to the specified phase or an earlier building 

phase are included in the energy analysis. Elements and masses assigned to a later building phase 

are omitted from the energy analysis. 

Analytical Space Resolution and Analytical Surface Resolution 
The Analytical Space Resolution parameter and the Analytical Surface Resolution parameter provide 

important information used by the algorithm that generates the energy model. 

The default values for these parameters provide an optimum balance between energy model 

accuracy and processing time for most Revit models. However, because Revit model size, 

complexity, and quality can vary widely, you may need to modify these parameters to provide 

greater accuracy or to reduce processing time of the energy model, or both. 

When you increase the values for Analytical Space Resolution and Analytical Surface Resolution, the 

processing time required to create the energy model is significantly reduced. Conversely, when you 

reduce the values for these parameters, the processing time required to create the energy model 

increases. 

Reducing these values does not necessarily result in a more accurate energy model. For example, 

while a lower Analytical Space Resolution value can result in smaller gaps between Revit elements, it 

can also lead to the omission of some analytical spaces due to gaps between architectural elements 

that were ignored at the higher setting. 

http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-D70A2D2C-1861-4D5C-B565-37AAE8D549EE
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-A68ABA83-4B82-4EF7-AF6B-38EADC36794E
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-3FAD7687-575C-43B4-B21A-D6085DF72912
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Experiment with different values in various models to understand how these parameters work. See 

also About the Energy Model Creation Process, About Spaces in the Energy Model, and About 

Surfaces in the Energy Model. 

Perimeter Zone Depth 

Specify the distance to measure inward from the exterior walls to define the perimeter zone. This 

setting should always be used in conjunction with the Perimeter Zone Division setting. 

 

The core of a building has heating and cooling loads that differ from the perimeter because it is not 

directly exposed to external weather conditions or daylight through windows. A typical perimeter 

zone depth is 12-15 feet (4-5 m). 

Setting the perimeter zone depth is a valuable part of automatic thermal zoning, especially for 

buildings with large open plans or for early massing studies. For more information, see About Spaces 

in the Energy Model. 

Perimeter Zone Division 

Select this option to divide the perimeter of the building (excluding the core) into discrete thermal 

zones. This setting should always be enabled when the Perimeter Zone Depth is greater than zero. 

Perimeter zones result in more accurate energy consumption estimates. For example, in the late 

summer afternoons, a west façade may encounter solar heat gain while the east façade does not. 

Perimeter zoning allows energy analysis of these perimeters to be handled separately. For more 

information, see About Spaces in the Energy Model. 

 

http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-DC9ECEA5-4646-4124-9226-A1FDE9D9BA38
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-AB6E64D9-D3DD-4104-89CD-F99B2F8C06F5
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-B22FC577-67B9-4922-B45A-6DA2963FD6F7
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-B22FC577-67B9-4922-B45A-6DA2963FD6F7
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-AB6E64D9-D3DD-4104-89CD-F99B2F8C06F5
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-AB6E64D9-D3DD-4104-89CD-F99B2F8C06F5
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-AB6E64D9-D3DD-4104-89CD-F99B2F8C06F5
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5. Preparing the Analytical Model by Adding Rooms 

After using Revit to create an analytical model, you can either export the model to DesignBuilder 

directly in Revit using the Use Rooms/Spaces Volumes option (method 1) or through the plugin 

(method 2). 

Preparation of the Revit analytical model is crucial to the success of the transition process. The 

analytical model is based around the definition of rooms which are superimposed on the underlying 

Revit architectural model. Any gbXML subsequently generated is based on the analytical model only 

and not on the underlying Revit architectural model. It is usually possible to create and make 

changes to the analytical model without modifying the underlying Revit model. 

Defining Rooms 

Rooms 

Revit Rooms maintain information on sub-divisions of space within the building.  In simple terms a 

room could literally be a room from the actual building or in some cases a collection of real world 

adjacent rooms. Rooms store values for a variety of parameters that affect subsequent building 

performance analysis such as volumes and the geometry of bounding elements. 

Rooms are identified based on bounding elements such as walls, floors, roofs, and ceilings. Revit 

refers to these room-bounding elements when computing the perimeter, area, and volume of a 

room. You can turn on/off the “Room bounding” property of these elements allowing flexibility in 

how rooms are configured. You can also use room separation lines to further subdivide space where 

no room-bounding elements exist. When you add, move, or delete room-bounding elements, the 

room’s dimensions update automatically. 

Note: An effective export can only be accomplished if all the areas in your model are defined 

by the Room components in the building model and the entire volume of the building model 

is included.  

The gbXML data exported from Revit is based mainly on rooms and their bounding elements. The 

DesignBuilder gbXML import mechanism identifies and converts these rooms into blocks and zones. 

Other building components like doors, windows and shading surfaces are created automatically as 

well. 

Note: Revit MEP uses the Space component instead of Rooms to maintain spacial 

information. Revit Architecture “Rooms” and Revit MEP “Spaces” are very similar but 

independent components used for different purposes. “Rooms” are architectural 

components used to maintain information about occupied areas. “Spaces” are exclusively 

used for the MEP disciplines to analyse volume. For the rest of this tutorial, except where 

distinctions are drawn, the terms “Space” and “Room” are used interchangeably. 

http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-3D8B61D3-38C6-4B8F-97E1-797A05F5C5AD
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-48509199-F248-4B61-9DC6-CEFBE2E302F2
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Room Boundaries 

The Volume of a Room is defined by limit parameters and Room-Bounding Elements. If room-

bounding elements occur within the range of the room’s defined limits, Revit uses the space defined 

by the room-bounding elements when computing the volume.  

In Revit the Upper Boundary (Upper Limit, Limit Offset, Level) and Lower Boundary (Base Offset) 

parameters define the height of the room. 

In the example shown below left, the false ceiling is a room-bounding element at 2400 mm above 

floor height. It occurs below the upper limit of a room specified with 2700 mm height. In this case 

Revit computes the room volume up to the room-bounding element and the ceiling void is not 

included in the analytical model. 

 
“Room bounding” property for the ceiling 

elements switched ON 

 
Room Bounding property for the ceiling 

elements switched OFF 

 

The false ceiling volume (indicated in white in the diagram above left) is not included in the zone 

volume which is shown in blue. In this case, you could turn off the Room Bounding property for the 

ceiling elements to ensure that the zone includes the ceiling void volume within the main occupied 

zone. This change is shown in the diagram above right. 

Note: you can easily add zone voids in DesignBuilder to obtain the correct zone volume etc. 

Defining the upper boundary of a room 

Together, the Upper Limit and Limit Offset parameters define the upper boundary of the room. 

The following figure shows two samples of Rooms with these parameters defined: 

• Room Zone A is double-height and has an Upper Limit of Level 0 and a Limit Offset of 6000. 

• Room Zone D has an Upper Limit of Level 1 and a Limit Offset of 3000. 

http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-22B6D041-F6D8-4DB0-8094-B325CC3CC6B4
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-241430FC-8084-43A1-AA3A-681B2883B0FC
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-C3040C34-62FC-4F31-9594-1082CFF86FFE#GUID-C3040C34-62FC-4F31-9594-1082CFF86FFE
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-A6916549-A031-4BA9-9360-556A37ACAC8F
http://www.designbuilder.co.uk/helpv5.4/#GeometryAreasAndVolumes.htm
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Defining the lower boundary of a room 

Together, the Level and Base Offset parameters define the lower boundary of a room. 

For the model above, the defined parameters are: 

• Room Zone A has a Base Offset of 0. The lower boundary of the room starts at Level 0, i.e. 

from the top of the ground floor slab. 

• Room Zone D has a Base Offset of –200. The lower boundary of the room starts 200 mm 

below Level 1. This allows the volume of the external floor slab to be included within the 

volume of the room. This is indicated by the highlighted blue shading overlapping the 

external floor slab element in the figure above. 

Zone Volume computations 

The volume computation for a space is based on its room-bounding components and is calculated as 

the area of its base multiplied by the height of the space. In Revit, both area and volume are 

calculated to wall faces. 

By default, Revit does not compute room volumes. You must switch on “Area and Volumes” in the 
Volume Computations panel under the Computations tab of the Area and Volume Computations 
dialog before exporting your model (see Enabling Volume Computations). 

http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-84D8BC77-AAF3-4F45-B77E-58E35858D3AA
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The Revit section views below illustrate the effect of these settings on the exported DesignBuilder 
model. 

 “Areas only (faster)” Volume Computations option - incorrect zones are created in the 
DesignBuilder model. 

 

 
“Areas and Volumes” Volume Computations option – correct zones generated in the 
DesignBuilder model below. 
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The Room volume defined in Revit should be approximately the same as the zone volume in 

DesignBuilder. 

Placing a room 

It is necessary to Create a Room for all spaces occupied and unoccupied before generating the 

gbXML or to use the plugin. After you have placed room components in all the areas in a plan, you 

can export your design as a gbXML file to perform a load analysis of your model in DesignBuilder 

software. 

In order to facilitate the visualisation of the rooms you can Control the Visibility of Rooms to make 

rooms and their reference lines visible as well as Color Schemes. 

 

You can use the Room Separation Lines tool to add and adjust room boundaries. They are useful for 

designating one room within another when there aren´t walls. In the sample above Room separation 

lines are room-bounding between the kitchen, living room and corridor zones. 

Note: It is possible to place the Rooms automatically in all closed bounded areas. In other 

areas the room placement must be carried out manually.  

Checking the Analytical Model 

Before exporting to gbXML you should check for potential problems that might affect the success of 

the transition process. It is also important to make sure that the model is correctly configured for 

export. We advise these checks on the Revit model before attempting the export: 

1. Check Revit Rooms 

2. Check individual zone volumes 

These are described below. 

http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-B3420A54-A9BC-4AEE-A07C-CD7A9DC782FB
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-35838C67-A54C-44BF-A4BA-1217326FFB12
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-4809E31D-8385-4EB9-89C2-B58D7FB25B00
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-6B8BDC71-D0A4-4ABA-8561-34F7AD6BAB55
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-D94E11E7-0956-4B5B-B50F-6BB28AD09F15


DesignBuilder Revit – gbXML Tutorial  

20 
 

Check Revit Rooms 

The first test allows you to verify the model through the Export gbXML dialog, which can be accessed 

from the upper right corner by clicking on the “Export gbXML” menu entry from the File menu. The 

dialog has two tabs, General and Details.  

On the Details tab it is possible check for possible warnings. If a warning is displayed for the Room, 

you should check the cause (see figure below), cancel and correct the problem in the building model. 

Review and correct warnings until all have been resolved throughout the model to avoid the 

problem carrying through to the DesignBuilder model. 

For example, in the figure below warnings in the Room 2 and Room 3 are shown on the dialog 

details tab. 

 

You can use the Export gbXML dialog to visually detect gaps between zones in the analytical model. 

You should generally aim to avoid gaps in the analytical model to ensure correct zone volumes and 

adjacencies in the DesignBuilder model. For example in the model below you can see gaps (shown in 

white) between the 3 floors of the model. 

 

http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-89B09D35-4CDE-458C-AFBD-492FCDB66E9A
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In this case the gaps were eliminated from the analytical model by using the steps explained in the 

Room Boundaries section. 

Tips 

Ensuring Rooms are Enclosed 

Rooms in Revit must have a properly enclosed region. When Revit fails to identify a room as 

expected, the first step is usually to check the surrounding elements. For example, the figure below 

shows a case of a non-enclosed region that was solved by attaching the walls to the pitched roof. 

 

Excluding elements from the energy model 

Some elements should not be included as part of the energy model. In Revit, you can switch on/off 

the Room Bounding parameter of many elements. In the example below the room-bounding setting 

of the structural columns should be switched off to avoid seeing columns appearing in the 

DesignBuilder model. 

 

Another example is shown below where the round column on the corner was switched off by de-

selecting “room bounding” on the properties dialog to avoid complex surfaces in the energy model. 
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Before Fix 

                     

The Revit model and the corresponding DesignBuilder  model before the change, with the column 

being a room bounding element. 

After Fix 

                         

The Revit room and the corresponding DesignBuilder zone after de-selecting the column as a room 

bounding element. The DesignBuilder model following the fix will be more accurate and because 

there are less surfaces, calculations will run faster. 

Merging Zones 

It is possible to merge multiple similar zones by switching off the elements between the Rooms. In 

the model below, Rooms 3, 4 and 5 have been merged into 1 Room by switching of the “Room 

bounding” element property of the walls between them. The merged zone is shown in grey in the 

figure below. This method is useful for a preliminary thermal zoning for large models. Note in the 

DesignBuilder navigator panel (below right) just four zones were created from this model. 
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Nested Spaces 

GbXML does not currently support “nested” spaces, i.e. spaces wholly contained within another 

space. It is necessary to split the surrounding room in order to avoid the nested room problem. The 

way that this is done is shown below; you can use the “Room separation line” to split them. After 

this you must place a new room in the separated area. 

 

Export gbXML Dialog - Use Room/Space Volumes 

When you choose to export the model to gbXML using room/space volumes, use this dialog to 

specify settings and to validate the analytical model before exporting it. 
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To open the Export gbXML dialog 

1. Open a 3D view of the model. 

2. Click File tab Export (gbXML). 

3. In the Export gbXML dialog, select Use Room/Space Volumes. 

The Export gbXML dialog displays. 

General tab 

g. Building Type: Specifies the type of building according to the gbXML schema 0.37 (similar to 
ASHRAE). 

h. Location: Specifies the geographic location for the model. The location establishes the climate and 
temperatures used in loads calculation. 

i. Ground Plane: Specifies the level that serves as the ground level reference for the building. Surfaces 
below this level are considered to be underground. The default level is zero. 

j. Export Category: Determines which information is to be exported and used for 
analysis: Rooms or Spaces. This setting determines which parameters are available on the General 
tab, as well as the information displayed on the Details tab. 

k. Export Complexity: Specifies the level of detail provided for openings, and whether shading surface 
information is exported. Shading surfaces are surfaces that are not adjacent to any space, and 
include surfaces that create a solar obstruction. Simple complexity is used for heating and cooling 
loads analysis. 

o Simple - curtain walls and curtain systems are exported as a single opening (without individual 
panels). Simple is more appropriate for energy analysis. 

o Simple with shading surfaces - same as simple, but with shading surface information exported. 

o Complex - curtain walls and curtain systems are exported as multiple openings, panel by panel. 
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o Complex with shading surfaces - same as complex, but with shading surface information 
exported. 

Shading surfaces are not associated with any room/space (roof overhang, free-standing wall). 

o Complex with mullions and shading surfaces - same as complex, but with mullion and shading 
surface information exported. 

Mullions in curtain walls are exported as shading surfaces. A simple analytical shading surface is 
produced from mullions, based on the centerline, thickness, and offset settings. 

l. Detailed Elements: (available only when Export Category = Rooms) 

See Use Detailed Elements for Material Thermal Properties. 

m. Project Phase: Specifies the stage of construction to use for analysis. 

n. Sliver Space Tolerance. Specifies the tolerance for areas that will be considered sliver spaces. 

o. Building Envelope: Specifies the method to use to determine the building envelope. 

o Use Function Parameter. (default) This method uses the Function type parameter of walls, 
floors, and building pads to determine the building elements considered to be part of the 
building envelope. If a wall has one adjacent space, analytical surfaces originating from the wall 
are classified as exterior surfaces. If a wall has two adjacent spaces and its function is Exterior, 
Foundation, Retaining, or Soffit, analytical surfaces originating from the wall are classified as 
interior surfaces. If the wall's function is Interior or Core Shaft, analytical surfaces originating 
from the wall are classified as interior surfaces, regardless of the number of adjacent spaces. 

o Identify Exterior Elements. This method uses a combination of ray-casting and flood-fill 
algorithms to identify the building elements that are exposed to the outside of the building, the 
building envelope. Analytical surfaces originating from the building elements in the envelope are 
classified as exterior or shading surfaces. 

p. Building Service: Specifies the heating and cooling system for the building. 

q. Schematic Types: Specifies the constructions type for the building. Click  to open the Schematic 
Types dialog, where you can specify the materials and insulation (U-values) for the building. 

r. Building Infiltration Class: Specifies an estimate of outdoor air that enters the building through leaks 
in the building envelope. 

Infiltration can be specified as: 

o Loose - 0.076 cfm/sqft for tightly constructed walls. 

o Medium - 0.038 cfm/sqft for tightly constructed walls. 

o Tight - 0.019 cfm/sqft for tightly constructed walls 

o None - infiltration is excluded from the calculation of loads. 

s. Export Default Values: (available only when Export Category = Spaces) 

Exports user-specified values as well as default values for People, Electrical Loads, Occupancy, 

Lighting, Power Schedules, and Construction Types. Clear this option to export only user-specified 

values. 

http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-3C378374-D360-4207-A558-3500922A452E
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Details tab 

When you set Export Category to Rooms on the General tab, the Details tab displays rooms in the 

model. Select an item in the list, and use the Highlight, Isolate, and Show Related Warnings tools to 

inspect the item. 

When you set Export Category to Spaces on the General tab, the Details tab displays spaces and 

zones in the model. In addition to inspecting spaces, zones, and related analytical surfaces, you can 

change related settings. See About the Details Tab, Specify Heating and Cooling Parameters for 

Spaces, and Specify Heating and Cooling Parameters for Zones. 

It can be worth testing various of the above options to see which provide the best translation into 

DesignBuilder format. 

6. Example Cases 

The example cases below use the same rac_basic_sample_project.rvt sample model provided with 

Revit to illustrate the overall Revit to DesignBuilder transition process through three different 

methods: 

• Example 1 - Revit Plugin (Simple with shading surfaces) 

• Example 2 - Revit Plugin (Complex with shading surfaces) 

• Example 3 - Built-in Revit gbXML export 

  

http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-31C6910D-CF34-4409-A271-1F4D2B8F5B17
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-6B5EA962-6815-428F-B463-980D888705DB
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-6B5EA962-6815-428F-B463-980D888705DB
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-2E8BEC9F-2637-4C6F-BF03-BFDC1A53B2C7
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Example 1 - Revit Plugin (Simple with shading surfaces) 

In this first example the DesignBuilder Revit plugin is used with default settings to load the 

rac_basic_sample_project.rvt model that is provided with Revit installations into DesignBuilder. The 

example shows some preparatory steps in Revit to ensure correct gbXML generation, use of the 

Plugin and some minor tidying in the resultant model in DesignBuilder. It also demonstrates how to 

set the Revit material and construction thermal properties to ensure that they are accurately carried 

through into the DesignBuilder energy model. 

Steps in Revit 

1- Open the Revit sample model rac_basic_sample_project.rvt from C:\Program 

Files\Autodesk\Revit 2018\Samples 

 

2- Unselect the Room Bounding settings for some components: 

Round column at level 1: 
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Internal floors: 

 

Ceilings: 

 

 

Internal walls: 

 



DesignBuilder Revit – gbXML Tutorial  

29 
 

3- Set the Limit Offset and Base offset 

Room 106 Living 

 

All Rooms in the first floor - Level 2: 

 

All Rooms in the ground floor – Level 1: 
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4- Open the Plugin Settings from Analyze toolbar and select the options Use room/space 

volumes and Simple with shading surfaces at the Advanced tab 

  

5- Click on the DB-Revit plugin icon to open the model in DesignBuilder (Turn off DesignBuilder 

first if it is opened) 

 

Steps in DesignBuilder 

6- Delete the windows that are not required in the DB model in zones 205 Bath and 202 

bedroom. 

              

Note: these erroneous windows are included in the Revit Analytical model and hence the 

gbXML generated by Revit. 
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7- Adjust the shading surfaces by deleting those not required and creating those that were not 

imported. For example: 

                       

 

8- Check the construction assignment 

Once the Revit model has been loaded into DesignBuilder, it is important to check that any 

construction assignments made in Revit are carried through into DesignBuilder. To do this, navigate 

to a selection of surfaces to check the construction assignments are set as expected in 

DesignBuilder. Note that these construction assignments are only made if: 

a) The Import thermal properties request was set on the Revit plugin Settings dialog, and, 

b) The construction and its layers of materials with thermal properties were correctly made in 

Revit. 

For example, in DesignBuilder, navigating to the larger pitched roof surface in 204 Bedroom we can 

see that the Basic Roof SG Metal Panels roof assignment has been made: 

 

The equivalent settings in Revit can be checked as follows. Navigating to the equivalent roof surface 

in Revit you can see that the Basic Roof SG Metal Panels roof has been set: 
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You should see that in this Revit assembly is made up of four material layers. However, the thermal 

properties for Roofing – Metal Standing Seam and Wood – Furring have not been set up: 

 
 

Material Roofing – Metal Standing Seam (image below) doesn’t have thermal properties. The Edit 

Assembly dialog itself does not indicate any missing thermal properties so it is important to check 

that thermal property data has been entered at material level for all materials used: 
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Material Softwood, Lumber does have thermal properties: 

 

Material Wood – Furring doesn’t have thermal properties: 

 

Material Gypsum Wall Board does have thermal properties: 

 



DesignBuilder Revit – gbXML Tutorial  

34 
 

In this case, Revit only provides the material settings for Softwood, Lumber and Gypsum Wall 

Board, which have thermal properties included on their settings, so the roof construction 

transferred to DesignBuilder is missing the other layers: 

 

Also, for some surfaces in DesignBuilder, you will notice that construction assignments have not 

been carried across from Revit at all. For example, navigating to the external floor surface in 101 

Kitchen, you will see that the DesignBuilder default Project external floor is still inherited from 

building level: 

 

To understand the reason for this it is necessary to check the settings in the Revit model.  Looking at 

the thermal properties for the Revit constructions: Floor: Generic 150mm, which is assigned to this 

floor in Revit, you can see that the thermal properties have not been completed in the Revit example 

model: 

   

As a final part of the exercise you should re-open the example model in Revit and set up the 

constructions, materials and enter thermal properties for all constructions and assign them to the 

appropriate objects before exporting the model again into DesignBuilder. 

The process involved is described in the Revit help: 
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http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-3C378374-D360-4207-A558-

3500922A452E  

  

http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-3C378374-D360-4207-A558-3500922A452E
http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-3C378374-D360-4207-A558-3500922A452E
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Example 2 - Revit Plugin (Complex with shading surfaces) 

The second example shows a similar process to the first example where the DesignBuilder Revit 

plugin is used to load the Revit sample model rac_basic_sample_project.rvt into DesignBuilder. This 

example however uses the Complex with shading surfaces Export complexity setting to illustrate 

how to deal with Open manifold blocks in DesignBuilder when they occur.  

Where steps are the same as for Example 1 the reader is referred back to that Example to avoid 

repetition. 

Steps in Revit 

1- Open the Revit sample model rac_basic_sample_project.rvt from C:\Program 

Files\Autodesk\Revit 2018\Samples 

 

The same process should be used as described for the Plugin in Example 1 above 

 

2- Unselect the Room Bounding settings for some components  

 

The same process should be used as described for the Plugin in Example 1 above 

 

3- Set the Limit Offset and Base offset 

 

The same process should be used as described for the Plugin in Example 1 above 

 

4- Open the Plugin Settings from Analyze toolbar and select the options Use room/space 

volumes and Complex with shading surfaces at the Advanced tab 

  

5- Click on the DB-Revit plugin icon to open the model in DesignBuilder (Turn off DesignBuilder 

first if it is opened) 

The same process should be used as described for the Plugin in Example 1 above 

Steps in DesignBuilder 

6- Delete the windows that are not required in the DB model in zones 205 Bath and 202 

bedroom. 
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The same process should be used as described for the Plugin in Example 1 above 

7- Adjust the shading surfaces by deleting those not required and creating those that were not 

imported. 

The same process should be used as described for the Plugin in Example 1 above 

8- Check the construction assignment 

The same process should be used as described for the Plugin in Example 1 above 

9- Flip block surface orientation of the block 206 Master Bedroom 

The Flip block surface orientation command should be used to fix the orientation of some surfaces in 
this open manifold block. When the Flip Block Surface Orientation command is active you can click 
on the surfaces in a block to see their orientation. You should aim to see the red arrow pointing 
outwards away from the centre of the block as shown below for all block surfaces in this Open 
manifold block: 
 

 

.  

https://www.designbuilder.co.uk/helpv5.3/#FlipBlockSurfaceOrientation.htm
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Example 3 - Built-in Revit gbXML export 

The third example uses the same rac_basic_sample_project.rvt model as Examples 1 and 2, but 

instead of using the Plugin, a more manual process involving the Revit Export gbXML and 

DesignBuilder Import gbXML tools is used. Because the Simple with shading surfaces Export 

complexity option is selected, the end result should be equivalent to the DesignBuilder model 

generated in the first example. 

Where steps are the same as for Example 1 the reader is referred back to that Example to avoid 

repetition. 

Steps in Revit 

1- Open the Revit sample model rac_basic_sample_project.rvt from C:\Program 

Files\Autodesk\Revit 2018\Samples 

 

The same process should be used as described for the Plugin in Example 1 above 

 

2- Unselect the Room Bounding settings for some components  

 

The same process should be used as described for the Plugin in Example 1 above 

 

3- Set the Limit Offset and Base offset 

 

The same process should be used as described for the Plugin in Example 1 above 

 

4- Export the gbXML file from the Menu File -> Export -> gbXML. Choose the Use Room/Space 

Volumes method on the Export gbXML dialog 
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Steps in DesignBuilder 

5- Import the gbXML file 

 

6- Delete the windows that are not required in the DB model in zones 205 Bath and 202 

bedroom.  
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The same process should be used as described for the Plugin in Example 1 above 

 

7- Adjust the shading surfaces by deleting those not required and creating those that were not 

imported. 

 

The same process should be used as described for the Plugin in Example 1 above 

 

8- Check the construction assignment 

 

The same process should be used as described for the Plugin in Example 1 above 

7. Advice 

This tutorial explains methods that can be used to transition a model from Revit to DesignBuilder 

and the impact of applying the main options. Some key learning points can be summarised as: 

a. The decision as to whether to use the DesignBuilder Revit Plugin is a matter of personal 

preference, however the Plugin simplifies and automates the process, so in general it is 

best to use it. 

b. When using the AM method, before even attempting the transfer, it is essential to set the 

Revit model up correctly by following steps described in the Preparing the Analytical Model 

by Adding Rooms section. 

c. The EAM is much quicker to use that the AM as it does not require the rooms to be set up, 

so it may be worth trying that first. However in most cases the manual intervention allowed 

by the AM approach gives a much more accurate transition. For the Revit sample model 

used in this tutorial, the AM provided the best results provided the preparatory steps 

described in Example 1 are followed.  

d. The Priority setting (on the DesignBuilder Settings dialog when using the Plugin or on the 

DesignBuilder Import BIM Model dialog when using the Export/Import method) is an 

important choice that will normally affect the quality of the data transfer. The Minimise 

gaps between blocks option typically gives the best results for the majority Revit models so 

you should try that first.  

e. It is important to carefully check the DesignBuilder model generated before using it for 

further analysis. Checks include making sure that any open manifold blocks have their 

surfaces correctly orientated, ensuring that all windows and doors have been transferred 

and that any thermal properties defined in Revit have been retained. 

f. Note that regardless of the transition method used, DesignBuilder only imports the 

geometry and the thermal properties of the materials through its gbXML import capability. 

Any settings made in Revit to define occupancy, lighting and HVAC are not transferred to 

DesignBuilder. 


